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1. Getting started with Issue Manager

What is Issue Manager?

Issue Manager tracks problems, or issues, with a product by letting you manage the review, approval,
and implementation of the issue. Using Issue Manager, you:

* Define — Gather information about a problem, including relevant parts, snapshots of the issue from
NX or Lifecycle Visualization, and reference data.

* Classify — Determine its risk level and priority.

* Investigate and fix — Perform root cause analysis and develop a resolution for the issue.

|
|

Define J
|

Classify J

|

Investigate and Fix J

You start a workflow to analyze the problem and send it to the assigned participants.

You can also use Issue Manager to manage penetration requests that were created in NX or
Teamcenter visual issues.

When should you use Issue Manager?

Use Issue Manager to manage issues that:

* Have highly visual information. Issue Manager automatically provides access to Siemens Digital
Industries Software design review and issue resolution tools, including NX, Lifecycle Visualization,
and the Lifecycle Viewer.

* Do not need to be addressed through an extensive, standardized change management process, such
as the one that Change Manager supports.
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_ 1. Getting started with Issue Manager

For example, use Issue Manager if the issue's fix does not require a product structure change because
Issue Manager does not provide features to manage product structure changes, such as removing,
adding, or replacing product nodes.

If you determine that an issue should be managed by Change Manager, you can change an issue into
a change report.

Types of issues you can create in Issue Manager

Using Issue Manager, you can manage many types of objects, In addition to creating a basic issue report,
you can:

Use an issue report to track and fix issues with a product.

Create Teamcenter visual issues to capture and track design problems with 2D images and 3D
models. You create the visual issue in Lifecycle Viewer or the Lifecycle Visualization stand-alone
viewer and manage them in Issue Manager.

Create penetration requests to request a hole cut in a structure. You create penetration requests in
NX and you can manage them in either NX or Issue Manager.

For more information, see the NX documentation.

Understanding the issue management process

Ways to manage an issue

There are two ways to manage an issue report:

The change specialist sets up Teamcenter workflow process for all participants.

Workflow tasks, such as issue review, issue fix, or final approval review are dispatched to assignees
automatically when the tasks become current. All team members are guided by the workflow process.
Issue status is tracked and updated automatically.

The change specialist uses the workflow process as a guide through the process.

Only the change specialist interacts with the Teamcenter workflow process. Review meetings are
organized and meeting decisions are manually tracked. Issue status can be tracked by the workflow
handler.

Basic tasks in an issue management process

* Arequestor identifies a problem and creates an issue report to track and manage it.
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Basic tasks in an issue management process _

The change specialist assigns participants as the analyst and reviewers.

Participants elaborate on the issue by gathering supporting reference data, such as snapshots and
parts, and store them in folders or datasets associated with the issue.

The change specialist starts a workflow to automatically step through the review and resolution
process.

Reviewers review the issue and the proposed solution. When they approve the solution, it is assigned
to the analyst to fix.

The analyst executes the change by creating and revising affected items.
Reviewers sign off on the fix.

The change specialist closes the issue.
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_ 1. Getting started with Issue Manager
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About the participants in issue management process

Different types of users are involved in various phases of the issue management process. Depending on
the complexity of the issue, the same person may perform many roles, or many people may perform the
same role.

The issue management workflows are set up by default to automatically assign issue review members
from the issue participants. For example, an issue management workflow can automatically assign
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Types of participants _

workflow tasks to the appropriate users based on their participant type. This is referred to as dynamic
participants.

See your workflow administrator for how your company’s issue management workflows are configured
or learn more about extending dynamic participants.

Note:
* Rules that control who can perform what and at what stage of the change process are defined
as Change Manager conditions.

* Change contributors can also be added. Change contributors can create solutions for the
change notice just like an analyst. They act as a secondary analyst.

Types of participants

Participants Description

Creates an issue report or is delegated an issue report

by another requestor. The requestor is responsible for
elaborating the definition of an issue and for providing as
much detail as possible to define the problem or request at
hand. A requestor may perform the elaboration, or a change
specialist may delegate responsibility for elaborating an issue
to another user (an analyst or requestor).

Requestor

When you create an issue report, you are its requestor. If
responsibility is delegated to another user, that user becomes
the current requestor and you are no longer the requestor.

Assesses the technical feasibility of an issue or the technical
feasibility of implementing the low-level details of an issue.
An analyst elaborates the details of an issue by providing a
technical recommendation, performing an impact analysis,
and planning the implementation. The analyst may perform
the implementation or delegate the work to others. During
the implementation phase, the analyst monitors the issue
execution and is ultimately responsible for ensuring the
implementation is performed correctly and according to the
plan.

Analyst

This person is generally a senior technical person with
knowledge of technical issues and a site’s products and
business goals.

H Facilitates and manages movement of an issue through
the appropriate processes at a site. Change specialists also
work to continuously improve the issue management process
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_ 1. Getting started with Issue Manager

Participants Description
Change specialist itself. They have an understanding of product definitions and
(change administrators) a site’s issue management process.

Reviews, approves, and authorizes issues. Reviewers make a
business decision about whether an issue should proceed.

Reviewers are generally senior individuals from various
functional areas within a site or individuals who have

. expertise in some aspect of an issue.
Reviewers

Understanding the penetration request process

About the penetration request process

During ship design, routed systems need to pass through steel structures, but often routed CAD
designers do not have the background required to make changes to a ship’s structure. Therefore, the
routed CAD designer must request that a penetration be made in the structure of the ship.

Placement of pipe Hole cut object created to
through structure accommaodate pipe

Teamcenter and NX provide all the tools you need to create, track, and respond to penetration requests.
A penetration request is created in NX and stored in Teamcenter. However, you can view, manage, and
act on the penetration requests without leaving the NX environment. In addition, using Teamcenter, you
can:

* Use Issue Manager to search for and view penetration requests. You can also send them through a
workflow process and view their progress.
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Participants in a penetration request _

» Use the Lifecycle Viewer to view selected elements or any portion of the structure.

Participants in a penetration request
There are three primary users in the penetration request management process:

» CAD designers (electrical, mechanical, or outfitter) who initiate the penetration request and add parts
and data into respective folders in NX.

* Hull technicians who evaluate, update, and approve or reject the request. Hull technicians may also
reassign the request to the CAD designer for rework.

 Structural designers who implement the requests, update structures in NX as needed, and sign off on
the work.

Other participants become involved if a penetration request needs to be escalated to a liability.

Basic tasks in a penetration request

* Arequest for a penetration begins in NX, where a designer modifies a part and makes a request
for a penetration, which is stored as a penetration request in Teamcenter. Designers can also define
multi-penetration requests and request that a penetration be removed or deleted.

* An administrator, called a change specialist, assigns participants to review and implement the request.

* The assigned hull technician reviews the request. The technician launches the routes and/or structures
in NX or Lifecycle Viewer and elaborates by updating properties and adding markups.

* When the hull technician approves the request, it is assigned to the structural designer to implement.
The hull technician can also reject the request.

* The structural designer executes the request by creating and revising the affected objects and signs off
on the task, closing the workflow.
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_ 1. Getting started with Issue Manager
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Before you begin

Prerequisites There is no licensing for Issue Manager.

Prerequisites include:

* Lifecycle Viewer if users want to access issues and data from Lifecycle Viewer
(create or update an issue or launch issue scene snapshots into Lifecycle
Visualization). A Lifecycle Viewer license is required.

* Change Manager
* Workflow

* Teamcenter Integration for NX if you want to manage penetration requests in

Teamcenter.
Enable Issue Issue Manager does not need to be enabled before you use it, but during
Manager installation, Issue Management must be selected, as well as its prerequisites:

* Under Extensions, select:
* Lifecycle Visualization and then:
m Teamcenter Visualization 9 (Embedded) for Rich Client
m Teamcenter Visualization 9 (Stand-alone) for Rich Client
* Enterprise Knowledge Foundation and then:

m Change Management
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m Issue Management

m Penetration Request Management

Note:

Penetration Request Management is required if you want to
manage penetration requests in Teamcenter.

To work with penetration requests you, must also install Teamcenter Integration
for NX.

Note:

You can log on to Teamcenter only once. If you try to log on to more than
one workstation at a time, you see an error message.

Configure Issue Issue Manager does not need to be configured. However, you may want to set
Manager these basic configurations:

» Set preferences for how issues and the images associated with them are
displayed.

* Create your own workflow processes to work with Issue Manager, although it
is not required because Issue Manager provides workflow processes for both
issues and penetration requests.

* Customize or remove the lists of values (LOVs)that appear in the New
Issue Report dialog box when users create an issue report and the Review
dialog box when users review an issue or penetration request.

Start

In the navigation pane, click Issue Manager E
Issue Manager —
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_ 1. Getting started with Issue Manager

Issue Manager interface
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1 Issue Home view Contains lists of issue report or penetration request

revisions based on searches defined by system
administrators and users.

2 Issue Manager perspective Contains views to display issue properties, snapshots of
issues, and related items.

Issue Manager tabs

Tab Description

Summary Displays the property information of the selected object.

Details Displays the children of the selected component in the Issue
tree.

Viewer Displays the registered viewer for the selected component in
the Issue tree.

Impact Analysis Provides graphical where-used and where-referenced search
capabilities.
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Tab Description

Issue Preview Displays thumbnail images captured before and after a fix for
each issue report or penetration request revision selected.

Issue List Details Displays details about all the issues, Teamcenter visual issues,
or penetration requests in a list, such as a list of all the issues
you created.

Issue Manager menus

All Issue Manager menus are standard Teamcenter rich client menus with the following additions.

Menu command Description

File*New-Issue Report Displays the New Issue Report dialog box and allows the
creation of an issue object.

Tools=2Assign Participants Assigns users, group members, or role members to
perform certain tasks during the review process.

Tools2>Review Issue Allows the review of an issue or penetration request
and the recording of a decision.

Issue Manager buttons

Button Description

Manage Issue Lists [ Displays the Manage Issue Lists dialog box and allows the
creation, modification, or deletion of searches to find issues,
visual issues, and penetration reports. This button is in the
Issue Home view.

What are perspectives and views?

Within the rich client user interface, application functionality is provided in perspectives and views.

View The basic display component that displays related information in a Ul window.

Perspective A collection of one or more views and their layout.

Some applications use a perspective with multiple views to arrange how functionality is presented.
Other applications use a perspective with a single view.

You can use the HiddenPerspectives preference to prevent the display of some Teamcenter perspectives
in the rich client.
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If your site has online help installed, you can access the application and view help from the rich client
Help menu.
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2. Creating issues and penetration requests

About creating issues and penetration requests

Using Issue Manager, you can manage many types of objects, including issue reports, Teamcenter visual
issues, and penetration requests. Any user can create an issue report to capture, track, and fix issues with
a product. You can also create an issue report in the context of the problem part and the problem report
is automatically added to the folder of problem items. For the other types of issues and penetration
requests, you create them in other applications, including NX, Lifecycle Viewer, ClearanceDB, and
Teamcenter Community Collaboration:

* To create a penetration request, use NX. For more information, see the NX documentation.
* To create a Teamcenter visual issue, use Lifecycle Viewer.

* To create a Visual Issue in NX, use NX and Teamcenter Community Collaboration. (These objects
are not managed in Teamcenter.)

You can also:
» Add related data to an object’s folders.

e Check out and update issue reports.

Note:

You cannot update a penetration request using Issue Manager. Instead, you must use NX. For
more information, see the NX documentation.

e Change an issue or penetration request into a change management object, such as a change
request.

Create an issue report

Any user can create an issue report in Teamcenter to capture, track, and fix issues with a product. The
issue can be created in the context of a part revision. The part revision is automatically copied to the
issue report Problem Items folder.

1. Choose File®*New=Issue Report->Create or choose File-*New-Issue Report->Create in
Context.

The New Issue Report dialog box appears. If you created it in the context of a part, the part that
you selected in Step 1 appears in the bottom portion of the dialog box.
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_ 2. Creating issues and penetration requests
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2. Inthe New Issue Report dialog box, select Issue Report and click Next.
3. Type a name in the Synopsis box and a description of the problem in the Description box.

You can also type an issue report ID and revision in the Issue No. and Revision boxes. If you do not
provide an ID and revision number, Teamcenter provides them automatically.

4. (Optional) From Design Review Gate and Issue Category, select an option.
Your system administrator can customize or remove these options.
5.  Click Finish.

If you created the issue report in the context of a part revision, the part revision is automatically
copied to the issue report Problem Items folder.

6. Copy and paste existing item revisions or datasets into the issue report revision as problem
parts, impacted parts, or reference items.

Update an issue

You can change the name and description of an issue report.
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Creating and reviewing Visual Issues in NX _

Note:

You cannot update a penetration request using Issue Manager. Instead, you must use NX. For
more information, see the NX documentation.

1. Select the issue report that you want to update.

Note:

You can update these objects only if you are the owner or have checkout and checkin
privileges granted by an access control list, access rules, or another method.

2. Click either the Summary or Viewer pane.
3. Click Check out and edit.
4. Change the following:

* Name

* Description

Note:

* You cannot edit the ID property.

* You cannot change the participants from the Summary or Viewer pane. Choose
Tools=2>Assign Participants instead.

5. Do one of the following:

* To save your changes in the Summary pane, click either Save properties and check in or Save
and keep checked out.

» To save your changes in the Viewer pane, click Save.

Creating and reviewing Visual Issues in NX

You can manage issues on 2D and 3D visualization data throughout the product life cycle by creating
Visual Issues in NX and managing them in Teamcenter community collaboration. You can update, lock,
and flag Visual Issues for attention. You can create Visual Issues either from your Web page or from
within your 2D and 3D viewer. Visual Issues is a feature that must be activated for your site collection.

For more information about Visual Issues, see the Teamcenter community collaboration or NX Help.
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_ 2. Creating issues and penetration requests

Create a change management report from an issue or penetration
request

If an issue or penetration request needs to be managed in Change Manager (for example, the issue's fix
requires a product structure change or there are two conflicting penetration requests called a liability),
you can change the issue report or penetration request into a change management report and manage
it using Change Manager.

1. Right-click the issue report or penetration request revision and choose Derive Change.

To create a change object from an issue report or penetration request, the
CM_change_derivations preference must have IssueReport/ProblemReport in its list of values.

When you change the issue report into a change management report, the change request is
automatically placed in the Implemented By folder. The behavior is the same as for a problem
report.

2. (Optional) Select Open on Create to open the derived change.

3. Click Finish.
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3. Managing issue data

Adding issue data

When you create an issue report, Teamcenter visual issue, or a penetration request, empty folders are
created for you to populate with objects related to it, such as supporting documents and objects that are
impacted by the issue. The following shows the folders created when you create an issue report. These
folders are shown as columns in the Issue List Details view.

= ER 1R-000001/8;1-ssue example
|2 R-000001 14
[ﬁ Implemented By
[ Problem Ttems
= [ﬁ Reference Ikems
=y Inch_dwg-Inch_dwg

- CRIR-000004781-test3

1 1R-000004/4

# ®impacied tems

= # prablam lems

= ®Reference llems

s Ppesue Imagea

= 4 |ssue Fixed Imacpe
. _."-‘ Txied

# ¥ subspt Snapshot

. & Enapshol Before Fix

# @ snapshat Afer Fix

You create the appropriate relations by adding objects to these folders, including search results. For
example:

* To create a relationship between a part and an issue, add the part revision to the issue's Problem
Items folder.

* To associate related information (such as analysis documents and system logs) with an issue, add any
Teamcenter object, including datasets, to the Reference Items folder.

You can also drag a file from the operating system. If you drag a file from the operating system and drop
it in the Reference Items folder, you are asked to create a new Teamcenter dataset.
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_ 3. Managing issue data

Note:

You can also set up images to display as thumbnails for quick viewing in the Preview Image
pane. The images do not appear in folders by default. You can change Teamcenter to display the
images in folders.

Contents of folders in an issue and penetration request

The following tables explain the contents of each folder associated with an issue or penetration request.

Learn about Teamcenter visual issues folders.
Issue reports and penetration requests

The following folders are automatically created for issue reports and penetration requests:

Reference data folders

This folder Contains

Problem Items  The part that must be modified to fix the issue. It should be a specific part revision.
It cannot be an item.

Reference Items  Information, such as analysis documents, text files, XML files, images, and system
logs, related to an issue or penetration request, including datasets. It can be
any workspace object that is useful for fixing the issues or penetration request,
including markups, ad-hoc notes, and images. It can also contain a stand-alone
viewer or the Lifecycle Viewer session file.

Implemented By Information about the implementation of the fix. It is generally left empty.

Note:

If you change the issue report into a change management report, the
Implemented By folder is automatically filled. The behavior is same as for a
penetration request.

Image data folders

The folder Contains
Issue Image Thumbnail images of an issue or penetration request before and after it is
fixed.
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Upload an image and attach it to an issue _

The folder Contains
Issue Fixed Image

Snapshot Before Fix One of the following visual data captured from Teamcenter lifecycle

. visualization:
Snapshot After Fix

* A 2D snapshot

* Product view, including the configured product structure (dynamic product
structure referencing Teamcenter configuration settings). Can be displayed
in the Structure Manager application.

Penetration requests

In addition to the folders listed in the previous table, a penetration request also has the following
folders:

The folder Contains

Penetrating Items  The routing parts (pipe, stock, and so on).

Penetrated Items  The structure items that are being penetrated for the request.

Subset Snapshot  The subset that has the recipe indicating the precise revision of structure part,
the routing part and the hole cut part, which you can launch in NX to view the
request in detail, loaded as it was when the request was created.

HangerPart The hanger part specified when the request was created.
StructureParts The structure items that are being penetrated for the request.
RoutingParts The routing parts (pipe, stock, and so on).

CompensationPart The compensation part specified by the user when the request was created.

HoleCutObject The new hole cut object part that is created for the request.

Upload an image and attach it to an issue

You can upload an image and attach it to an issue in Issue Manager using the File*New menu or the
Summary view.

1. InlIssue Manager, view the issue to which you want to add the image.
2. Do one of the following:

* Click the Summary view, select Issue Attachments, and click Add New.
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* Choose File-*New->Dataset.
3. From the Type list, select Image.
4.  Click Next.
5. Type a name in the Name box and a description of the image in the Description box.
6. Click Browse and navigate to a file. Click Open.
7. From the Reference List, select Image.

8. Select a relation, such as Issue Image. The relation you select determines the folder in which the
image is placed. The available relations are:

* Issue Image

* Issue Fixed Image

Subset Snapshot

Snapshot Before Fix

Snapshot After Fix
9. Click OK.

The dataset is attached to the issue in the appropriate folder.

Attach an existing image to an issue

You can manually attach images, such as 2D snapshots or product views, to issue report revisions.
1. Cutor copy an image, such as a 2D snapshot or product view dataset.

2. View the issue report revision in the Summary view.

3. Click Paste Special.

4. Select a relation, such as Issue Image. The relation you select determines the folder in which the
image is placed. The available relations are:

* |Issue Image

* Issue Fixed Image
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* Subset Snapshot

* Snapshot Before Fix

* Snapshot After Fix
5. Click OK.

The dataset is attached to the issue in the appropriate folder.
Delete data attached to an issue
1. Inthe Summary view, click Issue Attachments, and select the image you want to delete.

2. Click Cut.

The dataset is deleted from the issue.
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4. Viewing issues and penetration requests

About viewing issues and penetration requests

In Issue Manager, issues are organized in issue lists. By default, two issue lists are provided:

* My Issue Reports
List of issues that you created.

* My Signoff Issue Reports

List of issues in a workflow that require you to review them.

You can view the issue lists in the Issue Home as a list or in the Issue List Details view as a table.

f‘&; Issue Home X

Chijeck

=) '?."_’5 Issue Home

.‘1 My Issue Reports £ 1~ 15 173
Eﬂ My Signoff Issue Reports (0~ 00

[ Summary‘E’ DehilsTw Uimﬂ’\'r |mpactnna|>m;r:n; JEENTTENE o 1::ue List Details Tiiuas L;,||M,,1,,.,. Reports - B
My Issue Reports (1™ 3/3)
Lisue Image Snapshot Before Fix | Object = | Clasure | Tssue Category | Design Review Gate | Due Date | Sewverity Rating | Date Created

IR-00000124;1-te st

=
.

=5

=h

IR-00000274:1-test

IR-D00003/A;2-Newlssue  Open Styling

Open Shling Concept & Architecture

Open

Concept & Architecturs

13-Aug-2012 16:00

14-Aug-2012 11:17

14-Aug-2012 12:12

You can also set up your own issue lists for issue reports, Teamcenter visual issue, or penetration

request.

View issues and penetration requests as a list in the Issue Home

view

The Issue Home view displays issues in a list, one page at a time. By default, the size of the page is 15
issues. For example, in the figure, 15/17 indicates that it displays the first 15 of 17 issues when you open

the folder.
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M Issue Home 3¢

Cbject
=] ﬁﬂ-. Issue Home

= .jt My I=sue Repaorks m
% IR-000003)4; 1-Prablem wikh P
% IR-000002 )/ 4; 1-Problem with p
@ IR-000003)8; 1-Problem wikh p
% IR-000004)8; 1-Problem wikh p
% IR-000005)8; 1-Prablem wikh P
% IR-0000064; 1-Problem with P
@ IR-000007 ja; 1-Problem wikh P
% IR-000015)4; 1-Problem wikh P
% IR-000014)4; 1-Prablem wikh P
% IR-000009)4; 1-Problem with Py
@ IR-000010)8; 1-Problem wikh P
% IR-000011)4; 1-Problem wikh P
% IR-000012)4; 1-Prablem wikh P
% IR-000013)4; 1-Problem with P
ﬂ IR-000016)8; 1-Problem wikh P
4} Mext Page
w Load All

Eﬂ Py Signoff Issue Reports {0~ 0

FFHEHEH

FFHEHEH

FFHEHMH

F FH H

Note:

You can set the number of items displayed using the ISSUE_issuelist_page_size preference.

When you click on My Issue Reports, Teamcenter automatically switches to the Issue List Details tab
and collapses the Issue Home tab. Double-clicking on the Issue List Details tab returns you to the Issue
Home tab.

1. Inthe Issue Home view, click the issue list containing the issues you want to view. For example,
click My Issue Reports.

To run a search to be sure you have all the issues, right-click the issue list and choose Refresh.
The first page of issues appears.
2. To display the next page, below the list, click Next Page.

3. Todisplay all of the issues, below the list, click Load All.
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Viewing issues as a table in the Issue List Details view

About the Issue List Details view

You can view issue reports in an issue list as a table in the Issue List Details view. It allows you to see
all your issues quickly and view thumbnail images of the associated images. Once you see the issue or
image you are interested in, you can click it to display more information in the Issue Home view.

., s\mmauyEf Details == Viewer| © Impact Analysis| 54 Lsue Preview [F R T ATE

Tssues List Imksul Reports nd | |

i

My Issue Reports (1 7 3/73)

g

IR-000003/4;2-New Issue  Open
=

Styling

Issue Image Snapshot Before Fix | Object ~ ] Clasure | Issue Category | Design Review Gate | Due Date | Sewventy Rating | Date Created
IR-000001/4;1-test Open Styling Concept & Architecture 13-Aug-2012 18:00
= =]
TR-D0000Z7A;1-te st Open 14-Aug-2012 11:17

Concept & Architecture

14-Rug-2012 12:12

View issues in the Issue List Details view

1. Inlssue Manager in the Issue List Details view, set Issue List to the list of issues you want to

display, for example, My Issue Reports.

lssue Manager Issue List: |~ | [P

lssue Reports: Mo objects found
r Izsus Image: Enapshot Before Fix

My lssue I_-'-|l irts k=

The issues in the issue list appear in the Issue List Details table.

[P Issue Manager
Issue Reports: Wiewing 3 objects
[ — Snapshot Bators Fix  Object Closure  Issua Catagory Dasign Raviaw Gata
r % =
SAIR-000001 i1 mst — Open Stying Concept & Architscture
g il .
r 00000340 New bszue 0PN Stying Concept & Architecture

Dua Date Sevarity Rating Data Crazted

13-Aug-2012 18:00

1d-Aug-21211:17

14-Aug-20121212

2. (Optional) Do any of the following to make viewing easier:

Issue Management, Teamcenter 2412
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To Do this

Sort a column Click a column header.

Adjust the width of (Optional) Place the cursor between the columns and drag it to

columns change the width. The settings are saved across sessions and
settings.

You can also configure which columns are displayed and their order.

3. (Optional) Do any of the following to view more information about an issue in the Issue List

Details table:
To view Do this
The details of an issue and all  Double-click the issue in the Object column. The issue appears
its attachments in the Issue Home view.
An image Double-click the image. It appears in the browser.
A 2D snapshot or product Click the 2D snapshot or product structure in the Snapshot
structure Before Fix or Snapshot After Fix column. The viewer appears

with the image displayed.

Configure the columns of the Issue List Details view

You can show or hide the columns in the Issue List Details view and change their order. For example,
you may want to remove several of the image columns to improve the rate at which Teamcenter displays
the list of issues or to clear the display of all but the most important images. Any changes you make in
one client, such as the rich client, are reflected in the other.

Note:

To define which properties are available for viewing in columns of the Issue List Details view, use
the ISSUE_list_table_view_column_candidates preference.

1. From the Issue List Details view, click the View Settings tool [].

Issues List | My Issue Reports

\L

ISUrE | Issue Cateqgory | Design Review Gate | Due Datc_l Seventy Rating | Date Crested
Hyl stvling Concept & Architecture 13-Aug-2012 15:00

2. Inthe Configure View dialog box, use the right and left arrows to move the properties from the
Available Properties list to the Displayed Columns list and the reverse.
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Sﬂl’.nnfiuur: Yiew M= B

v alable Froperties 0 Displayed Columns

{Tssue Fixed Image - Issue Image

Subset Snapshot Snapshot Before Fix

Snapshat &fter Fix Object

Propesed Resporsible Party Closure

Proposed Reviewers Description

Type _'I Issue Categary ;I
heckad-Out By Design Review Gate

Chacked-Cut _4 | pus Date |
Last Maodifying Lser Sewerity Fating

Last Modfied Date - Requestor

[t Created

[ -

] _

ok |[Caeey ] gme |

3. To change the order of the displayed columns, select a property in the Displayed Columns list and
click the up or down arrow on the right to move its position.

4.  Click OK.
Previewing issue images

About previewing images

In the Image Preview view, you can quickly view thumbnail images of an issue or penetration request
before and after it is fixed. The image captured when the issue or request is created is on the left and
the image captured when the issue is fixed and ready for final approval is on the right. If an image is not
available, a blank area appears as shown in the figure.
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@ Find_issue_objects (1 - 15/23)

o R-OO000ALR |- [spae | bau Ireaps o RN |- [spuet | b Fix Inage

P

A title appears under each image made up of the issue report or penetration request revision and the
image names. When you move the cursor over a thumbnail image, tool tip information for the issue
report revision appears.

Preview issues are usually captured and saved from another application, such as NX or Lifecycle
Visualization, that is integrated with Issue Manager. You can copy an existing image dataset and use

the Paste Special command (select either the Issue Image or Issue Fixed Image relation type) to set up
the images that can be previewed.

Configuring previewing of issues and penetration requests

You can configure the following about the previewing of thumbnail images:
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L IR-000004/4;1-Issue5 ; Issue Fix Image

1 Size of the images Use the ISSUE_preview_image_size preference to change
the size of the preview. The default is 250 by 250 pixels.

2 Tool tip information By default:

* For the image before fix, the tool tip displays a short
description of the issue, design review gate options, the
issue category, and its due date.

* For the image after the fix, the tool tip displays
comments about the image.

Use the ISSUE_preview_tooltip_properties_before_fix
and ISSUE_preview_tooltip_properties_after_fix

preferences.
3 Delimiter between the two parts  Use the ISSUE_preview_image_name_separator
of the title preference to specify the delimiter that appears in the title

between the issue report revision and the image name.

Note:

You can also set up the images so they are stored in folders within the issue list in the Issue
Home view.

Issue Management, Teamcenter 2412 4-7
© 2025 Siemens
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Set up the images to be previewed

The following steps show how to set up an existing image dataset to appear as thumbnails to show an
issue before or after it is fixed.

1. If necessary, create a dataset containing an image before or after it is fixed.
2. Select the dataset and choose Edit->Copy.
3. Select the issue report revision to which you want to associate the dataset.
4. Choose Edit-Paste special.
The Paste dialog box appears, displaying a list of relation types.
5. Select either the Issue Image or Issue Fixed Image relation type.
6. Click OK.
7.  Click OK.
The dataset appears in the issue report revision. A flag appears next to it.

= % IR-00000214;1-issue  Issue Repor...

@ IR-000002)1 4 IssueRepor... Item Masters
ﬁ Implemented By Collection
[ﬁ IProblemItems Collection

¥ 13 Referenceltems  Collection
L FiTDs WR DirectMadel  Issue Image
L FITDS ﬁ DirectMadel  Issue Fixed Image

Store preview images in folders in issue lists

Preview images do not appear in folders by default in an issue list in the Issue Home view. You can
change Teamcenter to store the images in folders.

y IR-000001 /A, 3-test 1
Impactad [kems
Implemented By
[55e Floed Image
Isge Image

# [ IR-CO0001 A

+
& OleF €

1. Choose Edit-»Options.

The Options dialog box appears.
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2. Expand the General folder and select the Item Revision button.

The item revision options are displayed in the right pane of the dialog box.
3. Click the Related Object tab.
4. Inthe Available Relations list, select issue Fixed Image and Issue Image.

5. Click the + button to move the issue Fixed Image and Issue Image relations to the Shown
Relations list.

6. Click OK.
View preview issue images
1. Do one of the following:

* To display all the images from all the issue report revisions or penetration requests in an issue
list, in the Issue Home pane, select the issue list containing the issue.

Note:

You cannot highlight multiple issue lists.

* Expand the issue list and select the issue report revisions or penetration requests whose images
you want to preview.

2.  Click the Issue Preview pane.

The image captured when the issue is created is on the left and the image captured when the issue
is fixed and ready for final approval is on the right. If there are multiple images with these relation
types, Issue Manager displays the first image file.

Managing issue lists

About creating an issue list

You or your system administrator can define a list of issues, including Teamcenter visual issues and
penetration requests. For example, they appear with the default folders in the Issue Home view as
shown in the figure.
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M Issue Home M

Cbject

= M} Issue Home

I:E My Cuskom List
I:_,'g My Issue Reparts

I:_f'ﬂ My Signoff Issue Reports

Set the query data to be as specific as possible to ensure better performance when you expand the list.
You can have as many issue lists as you like. For example, for a penetration request, you might want to
create issue lists that display penetration requests by:

* Status (Working, Open, Holdup, Liability, Rejected, Complete, and so on)
* Design area

* Discipline (electrical, piping, hull outfitting, HVAC, and so on)

There are two kinds of issue lists:

» System-defined issue lists

Issue lists created by a Teamcenter administrator and shared by all users at a site. They are populated
by saved queries and do not require users to provide search criteria. Teamcenter administrators can
create, modify, or delete these issue lists.

The My Signoff Issue Reports issue list, shown in the figure above, is a system-defined issue list that
comes standard with Teamcenter.

To execute the search, expand the folder.
* User-defined issue lists

Issue lists created by individual users for their personal use that are unique to them.

Note:

A search name cannot contain a forward slash (/).

Create an issue list
1. Inthe Issue Home view, click Manage issue lists 3.

2. Inthe Manage issue lists dialog box, click Add.
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Select the type of issue list. The default type is User-defined. If you are an administrator, you can
select System-defined from the list if you want the issue list available to all users.

Leave the Show check box selected.
Click the Assigned search list to select the query template that is assigned to the issue list.

The list contains your user-defined saved queries and the following templates specific to Issue
Manager:

» _find_issue_objects
Finds all issue report revisions matching the criteria set in step 7.
* _find_issue_objects_2
Finds all items impacted by the issue and matching the criteria set in step 7.
* find_my_issue_reports
Finds all issues assigned to the user specified in step 7.
* _find_my_signoff_issues
Finds all issues assigned to the user specified in step 7.
* IssueReportRevision

Finds all issues using the criteria specified in step 7.

Note:

If you add a query template that requires the user to provide additional information, an error
is displayed when that issue list is opened by a user.

(Optional) Change the name of the issue list. Issue List name defaults to the name of the query
template you selected in the Assigned search list.

Configure the query that the issue list performs.
a. Click Configure.

b. In the Configure Search dialog box, set the options. The options depend on the type of query
you are creating.

c. Click OK.
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8. Click OK.

Refresh an issue list
1. Torefresh anissue list in the Issue Home view:
* If theissue list in the Issue Home view is closed, open it.
* If theissue list in the Issue Home view is already open, right-click it and choose Refresh.

2. Torefresh an issue list in the Issue List Details view, select another list and then select the desired
list again.

There is no refresh in the Issue List Details view.
Show or hide issue lists
1. Inthe Issue Home view, click Manage Issue Lists [j.
2. To hide an issue list, clear the issue list's Show check box in the Manage Issue Lists dialog box.
3. Todisplay a hidden issue list, select the issue list's Show check box.

4. Click OK.

Delete an issue list
1. Inthe Issue Home view, right-click the issue list folder and choose Delete.

You can delete your user-defined issue lists. You can delete system-defined issue lists only if you are
an administrator.

2. Inthe Delete issue list dialog box, click OK.




5. Working with Teamcenter visual issues

Teamcenter visual issues overview

You can use Teamcenter visual issues to capture and track design problems with 2D images and 3D
models. Created and viewed in the standalone viewer or the Lifecycle Viewer, visual issues are managed
in Issue Manager.

Visual issues consist of an issue report and an issue report revision, along with an automatically
generated product view, 2D snapshot, or session file. When reviewers send an issue report revision
to the standalone viewer or the Lifecycle Viewer, the visualization data associated with the issue is
displayed in the same state it was in when the issue was created.

Configuring Teamcenter visual issues

Configuring the viewer to work with Teamcenter visual issues

Use the following Teamcenter preferences to configure the standalone viewer to work with Teamcenter
visual issues:

Use this preference To do this

ManagedIssueServer Enable the creation of Teamcenter visual issues. When you send
visualization data from Teamcenter to the standalone viewer, the viewer
is automatically configured to create Teamcenter visual issues. However, if
you also use the Teamcenter community collaboration issue management
system, you may need to set ManagedlssueServer to true for the viewer
to create issues in the Teamcenter database.

ManagedissueList Specify the URL of your visual issues list. When you choose Review
tab—->Issues group—>View Issues List . in the standalone viewer, the
browser launches and displays either the default list of visual issues (all
issue report revisions) or a filtered list.

ManagedlssueListQuery Display a customized visual issues list. When you choose Review
tab—>Issues group—->View Issues List  , in the standalone viewer, the

browser launches and displays a visual issues list consisting of issue report
revisions that match the criteria of a Teamcenter saved search.

Enable Teamcenter visual issues

Set the Teamcenter ManagedlssueServer preference to true to enable Teamcenter visual issues in the
stand-alone viewer.
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1.

In Teamcenter, choose Edit->Options.

Near the bottom of the Options dialog box, click Index.

Options related to specifying preferences are displayed.

In Search On Preference Name, type ManagedlssueServer, and press Enter.
In Preferences List, click ManagedIssueServer.

The Preference Details section displays the current settings for the ManagedIssueServer
preference.

In Current Values, type true.

Click Modify.

The preference is saved.

Click Cancel to close the Options dialog box.

In Teamcenter, select an item revision that includes visualization data, and then choose File-»Open
in Lifecycle Visualization.

Teamcenter sends the visualization data to the stand-alone viewer. Once the data is loaded, the
viewer is configured to create Teamcenter visual issues.

Specify the URL of your Teamcenter issues list

You must use the Teamcenter ManagedlssueList preference to specify the URL where the issues list will

display. When you choose Review tab—Issues group—>View Issues List = ., in the standalone viewer,

the browser launches and displays the default list of visual issues.

1.

In Teamcenter, choose Edit->Options.

In the Options dialog box, click Search.

In Search On Preference Name, type ManagedissueList, and press Enter.

In Preferences List, click ManagedissuelList.

The Preference Details section displays the current settings for the ManagedIssuelList preference.

In Current Values, type the URL using this syntax:
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http://<URL>/#/showChanges

Example:

http://10.200.30.400:7001/#/showChanges

6. Click Modify.
The preference is saved.
7.  Click Cancel to close the Options dialog box.

8. In Teamcenter, select an item revision that includes visualization data, and choose File->Open in
Lifecycle Visualization.

Teamcenter sends the visualization data to the standalone viewer.
9. Choose Review tab—>Issues group->View Issues List = . .

The configured browser displays the default visual issues list.

Note:

The default visual issues list includes all of the issue report revisions that have been created.
Alternatively, you can use a Teamcenter saved search to display only visual issues that
match predefined search criteria.

Filter the Teamcenter visual issues list

You can use a Teamcenter saved search to filter the visual issues list according to your specified criteria.
1. In Teamcenter, choose Window—>Show View—Search.

2. Atthe top of the Search view, click Select a Search ] - .

3. Inthe Change Search dialog box, expand System Defined Searches, and then select IssueReport
Revision.

4. Click OK.
The issue report revision search options are displayed.
5. Construct your search by specifying criteria such as Issue Category and Issue Assignee.

6. Atthe top of the Search view, click Add Search to My Saved Searches =;..
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10.

11.

12.

13.

In the Add Search to My Saved Searches dialog box, type a name for the search, and then click
OK.

The search is saved.

Choose Edit—>Options.

Near the bottom of the Options dialog box, click Index.

Options related to specifying preferences are displayed.

In Search On Preference Name, type ManagedIssuelistQuery, and press Enter.

In Preferences List, select ManagedIssueListQuery.

The Preference Details section displays the current settings for the ManagedIssuelList preference.
In Current Values, type the name of the saved search.

Click Modify.

The preference is saved. When you display the visual issues list from the standalone viewer, it
includes only visual issues that match your predefined search criteria.

Creating Teamcenter visual issues

Creating Teamcenter visual issues

Teamcenter issue reports are used to capture and manage design problems. When you create a visual

iss

ue in the Lifecycle Viewer or the standalone viewer, the state of the viewer is captured by a 2D

snapshot, product view, or session file, which is automatically attached to the issue. When reviewers

op

en the issue in the viewer, the associated visualization data is displayed for evaluation.

Visual issue creation involves the following tasks:

Understand the conditions under which different types of visualization datasets (2D snapshots,
product views, or session files) are generated and attached to visual issues.

Create a single visual issue in the Lifecycle Viewer or the standalone viewer.
Create visual issues from one or more 2D or 3D snapshots.
Create visual issues from one or more Clearance results.

Manually attach visualization datasets to an existing issue report revision.
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Visual issue dataset creation behavior

When you create a visual issue in the Lifecycle Viewer or the standalone viewer, the state of the viewer
is captured by a 2D snapshot, product view, or session file, which is automatically attached to the issue.
The type of visualization dataset generated and associated with the visual issue varies depending upon
these factors:

This

visualization

dataset Is created under these conditions

2D snapshot A 2D image is the active document in the viewer. The image also must be associated
with an item revision, or a session file is created instead of a snapshot.

Product view A 3D model is the active document in the viewer. In addition, the following
conditions must be met:
* The model must be associated with an item revision.
* The model must be larger than a single part.
* The model must include configured product structure (dynamic product structure

referencing Teamcenter configuration settings).

* The Viewing window must not include any inserted models.
If any of these conditions are not met, a session file is created instead of a product
view.

Session file A 2D image or 3D model is the active document in the viewer.

Create Teamcenter visual issues
You can create Teamcenter visual issues in the Lifecycle Viewer or the standalone viewer.

1. From Teamcenter, send an item revision that includes visualization data to the Lifecycle Viewer or
the standalone viewer.

2. Adjust the view of the image or model.

Tip:

Any changes you make to the state of the Viewing window are preserved by the visual issue,
including markups, measurements, and part or layer visibility.

3. Select the nodes in the tree that you would like to attach as problem items. If nothing is selected,
the parent node will be attached. If a leaf component node is selected, the problem item that is
associated with that issue will be the closest item revision ancestor to that leaf component node.
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On the Issues toolbar, click Create and log an issue .
- Or -

In the standalone viewer, choose Review tab->Issues group—>Add New Issue ..

The Visual Issue dialog box appears.

From the Type list, choose Issue report.

Note:

Issue Report is the default issue type. Your organization may also allow you to choose from
additional issue types.

In the Name box, type a name for the issue report.

In the Data Type for state information section, choose how you want to capture the state of the
viewer:

* Session File
* Product View or 2D Snapshot

Depending upon your data and your settings in the Teamcenter Integration Visual Issue
Preferences, the viewer may generate a 2D snapshot or product view when the issue is created.
Choose one of the following Teamcenter relation types for the dataset:

* Snapshot Before Fix
* Snapshot After Fix
Click OK.
The Issue Attribute Dialog appears, displaying the available attributes.
In the Issue Attribute Dialog, do the following:
a. Double-click Synopsis to provide a name for the issue report revision.
The Attribute Edit dialog box appears.
b. In Value, type a name for the issue report revision.

c. Double-click any of the other attributes to add information relevant to the issue.
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d. Click OK.

Note:

Depending upon the Teamcenter Integration Snapshot Preferences, you may need to
specify other information for a 2D snapshot or provide a name for a product view.

The viewer creates an issue report and an issue report revision, along with a 2D snapshot,
product view, or session file.

e. Ifa 2D snapshot or product view cannot be created, do the following to associate a new
session file with the issue:

A. If an error message is displayed, click OK to close it.
B. Inthe dialog box that asks you if you want to create a session file, click Yes.

A session file is created and attached to the visual issue.

Create Teamcenter visual issues from snapshots

You can create Teamcenter visual issues from 2D or 3D snapshots. If you have multiple snapshots, a
separate issue report is created for each selected snapshot.

1. From Teamcenter, send an item revision that includes visualization data to the Lifecycle Viewer or
the standalone viewer.

2. Create one or more snapshots.

3. Select the nodes in the tree that you would like to attach as problem items. If nothing is selected,
the parent node will be attached. If a leaf component node is selected, the problem item that is
associated with that issue will be the closest item revision ancestor to that leaf component node.

4. Select each snapshot from which you want to create a visual issue. For multiple selections, hold Ctrl
as you click each snapshot.

Tip:

Selected snapshots have a green border.

3 et

=i

5. Choose Actions—Issues—>From Snapshots.
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10.

_Or_

The Visual Issue dialog box appears.

From the Type list, choose Issue report.

Note:

Issue Report is the default issue type. Your organization may also allow you to choose from
additional issue types.

In the Name box, type a name for the issue report.

In the Data Type for state information section, choose how you want to capture the state of the
viewer:

* Session File
* Product View or 2D Snapshot

Depending upon your data and your settings in the Teamcenter Integration Visual Issue
Preferences, the viewer may generate a 2D snapshot or product view when the issue is created.
Choose one of the following Teamcenter relation types for the dataset:

* Snapshot Before Fix

* Snapshot After Fix
Click OK.
The Issue Attribute Dialog appears, displaying the available attributes.
In the Issue Attribute Dialog, do the following:
a. Double-click Synopsis to provide a name for the issue report revision.

The Attribute Edit dialog box appears.

b. InValue, type a name for the issue report revision.
c. Double-click any of the other attributes to add information relevant to the issue.

d. Click OK.
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e. If you selected multiple snapshots, the Issue Attribute Dialog appears for each snapshot. Add
information relevant to the issue, and click OK.

Create Teamcenter visual issues from clearance results

You can create Teamcenter visual issues from clearance results. A separate issue is created for each
specified result.

1. From Teamcenter, open a 3D model in the Lifecycle Viewer or the standalone viewer.
2. Perform a clearance check.

3. Inthe Results list, select one or more clearance results. For multiple selections, hold Ctrl as you
click each issue.

4. Right-click the clearance result, and select Create Issue(s).
The Visual Issue dialog box appears.

5.  From the Type list, choose Issue report.

Note:

Issue Report is the default issue type. Your organization may also allow you to choose from
additional issue types.

6. In the Name box, type a name for the issue report.

7. In the Data Type for state information section, choose how you want to capture the state of the
viewer:

* Session File
* Product View or 2D Snapshot

Depending upon your data and your settings in the Teamcenter Integration Visual Issue
Preferences, the viewer may generate a 2D snapshot or product view when the issue is created.
Choose one of the following Teamcenter relation types for the dataset:

* Snapshot Before Fix
* Snapshot After Fix
8. Click OK.

The Issue Attribute Dialog appears, displaying the available attributes.
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9.

In the Issue Attribute Dialog, do the following:
a. Double-click Synopsis to provide a name for the issue report revision.
The Attribute Edit dialog box appears.
b. In Value, type a name for the issue report revision.
c. Double-click any of the other attributes to add information relevant to the issue.
d. Click OK.
The Save As dialog box appears.
e. Type a name for the clearance results file, and click Save.
The clearance results file is saved to the database.

f.  If you are posting multiple clearance results, the Visual Issue and Issue Attribute Dialog
dialog boxes are displayed again. Complete the steps described above for each issue.

A new visual issue is created for each clearance issue selected in the Results list.

Attach visualization data to Teamcenter visual issues

You can manually attach 2D snapshots or product views to issue report revisions.

1.

Cut or copy a 2D snapshot or product view dataset.

Select the issue report revision.

4 Ef IR-000041/A;1-000204/A

Choose Edit-»Paste Special.

In the Paste Special dialog box, choose one of the following relations:
* Snapshot Before Fix

* Snapshot After Fix

Click OK.

The dataset is attached to the visual issue.
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4 7 IR-000041/A;1-000204/A
[# IR-000041/A
» [ﬁ Impacted Items
- I3 Implemented By
» ﬁ Problem Items
- I3 Reference tems
» [ﬁ Issue Image
- I3 Issue Fixed Image
- I5) Subset Snapshot
- |53 Snapshot Before Fix
4 [ﬁ Snapshot After Fix
iy 000204/8,1-2d 4

Note:

When an issue report revision is launched into the Lifecycle Viewer or the standalone viewer,
only 2D snapshot or product view in the Snapshot Before Fix and Snapshot After Fix
folders, or session files in the Reference Items folder, are automatically opened in the
viewer. All other pasted visualization data must be manually opened.

Reviewing Teamcenter visual issues

Reviewing Teamcenter visual issues overview

When a Teamcenter visual issue is created in the Lifecycle Viewer or the standalone viewer, an issue
report revision is added to the database, along with an associated 2D snapshot, product view, or session
file. Issue report revisions are typically accessed using issue lists in Issue Manager. You can configure
issue lists to include only visual issues that match search criteria such as Issue Category and Issue
Assignee.

To access your issues, you can launch Issue Manager from within the Lifecycle Viewer. You can also
choose to display a list of issues from within the standalone viewer.

When you open a visual issue in the Lifecycle Viewer or the standalone viewer, the visualization dataset
associated with the issue is automatically opened and displayed. You can also expand the issue report
revision object from an issue list, manually select a visualization dataset, and send it to a supported
viewer. You can open 2D snapshots, product views, and session files in the standalone viewer or the
Lifecycle Viewer. You can also open product views in Structure Manager.

After opening a visual issue in the viewer, you can choose to update the associated visualization dataset
or delete the issue report revision object from the database.

Create a visual issue list in Issue Manager

To access visual issues in Issue Manager, you must use an issue list. You can configure your issue list to
include only issues that match specific search criteria.
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1. Inlssue Manager, in the Issue Home view, click Manage Issue Lists [j.
The Manage Issue Lists dialog box appears.
2. Click Add.
A new issue list is displayed.
3. Inthe Issue List Name column, click New Issue List.
4. Type a name for the issue list, and press Enter.
5. Select the Show check box.
6. For Assigned Search, choose IssueReport Revision to create a custom search.
7.  Click Configure.
The Configure Search dialog box is displayed.
8.  Set the search options, and click OK.
The Configure Search dialog box closes.
9. Click OK.

The Manage Issue Lists dialog box closes. In the Issue Home view, the new issue list is displayed.
Expand the issue list to access the issues matching your search criteria.

Display a list of Teamcenter visual issues in the viewer

You can choose to display a list of visual issues from within the Lifecycle Viewer or the standalone
viewer.

On the Issues toolbar, click View existing issues .
- or -
In the standalone viewer, choose Review tab—Issues group—->View Issues List

In the standalone viewer, the configured browser displays the default list of visual issues. In the Lifecycle
Viewer, the Issue Manager opens.
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Note:

By default, the visual issues list displayed in the browser includes all issue report revisions. You can
also specify to display a list of visual issues that match predefined search criteria.

Search for visual issues in My Teamcenter
You can create and save custom search queries to access visual issues in My Teamcenter.

Create a saved search for visual issues

—_

In My Teamcenter, choose Window—-Show View—-Search.
2. Atthe top of the Search view, click Select a Search ] - .

3. Inthe Change Search dialog box, expand the System Defined Searches folder, and select
IssueReport Revision.

4. Click OK.
The IssueReport Revision search options are displayed.

5. Construct your search.

Example:

In Issue ID, type IR* to display a list of every issue. To narrow the scope of the search, specify
additional search options such as Issue Category and Issue Assignee.

o

At the top of the Search view, click Add Search to My Saved Searches =;..

N

In the Add Search to My Saved Searches dialog box, type a name for the search.
The search is saved and listed in your My Saved Searches folder.

Use a saved search for visual issues
1. In My Teamcenter, at the top of the Search view, click Select a Search 1 - .

2. Inthe Change Search dialog box, expand the My Saved Searches folder, and select a saved
search.

3. Click OK.
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The search is performed. If IssueReport Revisions matching your search query are found, they are
displayed in the Search Results view.

Open Teamcenter visual issues

You can send an issue report revision, along with an associated visualization dataset, to the standalone
viewer and the Lifecycle Viewer.

Do any of the following:

* To send a visual issue to the standalone viewer, select the issue report revision, and choose
File—>Open in Lifecycle Visualization.

* To send a visual issue to the Lifecycle Viewer, right-click the issue report revision, and choose Send
To-Lifecycle Viewer.

The visual issue opens in the viewer and the data is displayed in exactly the same state as it was in when
the issue was created or last updated. All 2D snapshots and product views with the Snapshot Before Fix
and Snapshot After Fix relations are displayed on the Snapshots tab of the Product Workspace window
(standalone viewer) or the Snapshots view (Lifecycle Viewer). A dashed border around the thumbnail
image indicates that a product view or 2D snapshot is associated with a visual issue.

2l x| B Snapshots x =| PMI| oS Assembly

””””””

FFFFErrrr

|

.
AR AR

FrFFrrrry]

ARRRARAAR

L Assembly E Snapshots

2D snapshot thumbnail in the standalone viewer Product view thumbnail in the Lifecycle Viewer

Open Teamcenter visual issue attachments

You can open Teamcenter visual issue attachments, including 2D snapshots, product views, and session
files, in the standalone viewer or the Lifecycle Viewer. You can also open product views in Structure
Manager.

1. Expand anissue report revision.

The issue folders are displayed.
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4 E:E IR-000080/41-Assy_CompPMIFilterdviews/B-View

[ IR-000060/A

» [ﬁ Impacted terns

> 53 Implemented By

> [ﬁ Problem Items
I3 Referencetems

» [ﬁ IssueImage

> I3 Issue Fixed Image

> |53 Snapshot Before Fix

> |53 Snapshot After Fix

2. Expand the folders to display visualization datasets, if present.

4 [ Snapshot Before Fix
» e 20110304 -145607

Note:

For an overview of the visual issue folder structure, see Teamcenter visual issue
attachments.

3. Do any of the following:

¢ To send a visualization dataset to the standalone viewer, select the dataset, and choose
File=>Open in Lifecycle Visualization.

* To send a visualization dataset to the Lifecycle Viewer, right-click the dataset, and choose Send
To-Lifecycle Viewer.

* To send a product view dataset to the Structure Manager, right-click the dataset, and choose
Send To—>Structure Manager.

Teamcenter visual issue attachments

Depending upon your data and the Teamcenter Integration Visual Issue Preferences in the viewer, the
following types of visualization data may be generated automatically when Teamcenter visual issues are
created.
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Visualization dataset type Visual issue folder Example
product views Snapshot Before Fix 4 Ef} R-000067/A;1-caster3_assm/A-View
Snapshot After Fix [ IR-000067/A

» 5y Impacted Items

- g Implemented By

s [ﬁ Problem Items

5 [ﬁ Reference ltems

» g Issuelmage

- I Issue Fixed Image

4 |3 Snapshot Before Fix
s =l 20110304-145607

» 5@ Snapshot After Fix

2D snapshots Snapshot Before Fix 4 Ef R-000131/A;1-000014/A
Snapshot After Fix [ IR-000131/A
> g Impacted Items
> |5 Implemented By
- Iy Problem ltems
5 [ﬁ Reference ltems
- Iy IssueImage
- |5y Issue Fixed Image
4 |3 Snapshot Before Fix
>y 00001474 1-Multi-sheet CGM
- I Snapshot After Fix

session files Reference Items 4 Eff R-000132/A:1-visSC_20110303-135254
[Z7 IR-000132/4
- g Impacted Items
> g Implemented By
> Iy Problem ltems
4 [} Reference Items
» iy Seszion
- Iy Issuelmage
» [ﬁ Issue Fixed Image
» 5y Snapshot Before Fix
- | Snapshot After Fix

Edit Teamcenter visual issues

In the Lifecycle Viewer or the standalone viewer, you can save new snapshots to an existing Teamcenter
visual issue or delete existing snapshots from the issue. You can also update a single snapshot.

1. Open the visual issue in the standalone viewer or the Lifecycle Viewer.

2. Modify the contents of the Viewing window.
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3. Inthe Snapshots view (Lifecycle Viewer) or on the Snapshots tab (standalone viewer), do one of
the following:

* To save new 2D snapshots or product views to the visual issue, select the new snapshots.

* To delete 2D snapshots or product views from the visual issue, right-click the snapshots that you
want to delete, and choose Delete.

* To update a single 2D snapshot or product view, select the snapshot associated with the visual
issue.

Tip:
A snapshot associated with a visual issue has a dashed border.

::::::::::

FrFrFFFIFFT ]
ARARRLRR

g,

4.  Onthe Issues toolbar, click Update existing issue .
- Or -
In the standalone viewer, choose Review tab—Issues group—->Update Existing Issue G

Delete Teamcenter visual issues in the viewer
You can delete Teamcenter visual issues directly in the standalone viewer or the Lifecycle Viewer.
1. Open the visual issue in the standalone viewer or the Lifecycle Viewer.
2. On the Issues toolbar, click Delete this issue .
-or-

In the standalone viewer, choose Review tab—>Issues group—>Delete Issue ...

The issue report and issue report revision are deleted.
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6. Reviewing and implementing issues and
penetration requests

Review an issue or penetration request

Note:

A penetration request can also be reviewed in NX. For more information, see the NX
documentation.

When an issue report is created in Teamcenter, it is only an incident report. Reviewers must investigate
and evaluate it. Only the issues that must be fixed immediately are assigned to an analyst. Rejected or
deferred issues are marked accordingly.

Only the issue report or penetration request revision objects that are pending for signoff can be
reviewed. If the revision object is not pending for you to sign off (either you are not a member of

the selected signoff team or the revision object is not in the workflow process), you receive the message
that you are not permitted to log a review decision or comment on it.

1. Select the issue report or penetration request revision to be reviewed.
2. Choose Tools=>Review Issue.

3. Selectareview decision. The following are the default review decisions for an issue. Your
administrator can set the options that appear.

* Defer
Defer an issue.
* Reject
Reject an issue.
* Close
Close an issue.
* Reopen
Opens a previously closed issue.

* Approve Issue
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Approve the issue investigation and agree to assign the issue for fixing.
e Submit Fix
Submit fix for final approval (done by the analyst only).
* Approve Fix
Approve the issue fix implemented by the analyst.
4. Type in comments explaining your decision.

5. Click OK.

Fix an issue or penetration request

Note:

A penetration request can also be fixed in NX. For more information, see the NX documentation.

The status of an issue or penetration request is updated as it is assigned and the fix is in progress.

1. Inthe appropriate tool, such as NX, make the required fix to the product, such as making a hole cut
in a structure.

2. Create snapshots, markups, or other documents verifying the fix.

If the issue report or penetration request is changed into a change management report, the
Implemented By folder is automatically filled. The behavior is same as when a problem report is
changed into a change request in Change Manager.

3. (Optional) Create an image to represent the fixed issue or hole cut and set it up for quick
previewing.

4.  Choose Tools->Review Issue and submit your fix for final approval.

Approve a fix made to an issue or penetration request

Note:

A penetration request can also be approved in NX. For more information, see the NX
documentation.

The fix for an issue or penetration request must be approved to close it as fixed.
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Approve a fix made to an issue or penetration request _

Because a rejection in a workflow perform signoff task holds up the workflow process, a reject decision
from a final reviewer is not desired. Therefore, the team should determine a solution that can be
approved. Final reviewers should communicate with the analyst who is applying the fix or with other
reviewers for questions and concerns with the fix.

1. Final reviewers launch the issue report or penetration request data into the respective application
(NX, Lifecycle Visualization, or other applications) to verify the fix made to the issue.

2.  Final reviewers communicate with the analyst (or other team members) with questions and
concerns.

3. Final reviewers do either or both of the following:
* Approve the fix or hole cut from the workflow signoff task.

* Choose Tools->Review Issue->Approve Fix.

Note:

If you complete the signoff in the workflow process (without choosing Tools->Review
Issue=>Approve Fix), you do not cast a vote. You only move the workflow forward; there
is no vote for you recorded.
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7. Managing the issue process

About managing the workflow process

Manage the review, approval, and implementation of an issue or penetration request through a
Teamcenter workflow process. Issue Manager provides sample issue management and penetration
request process templates.

You can customize the following:
* The sample workflow templates. You can also create your own.

* The review decisions that appear when a user reviews an issue or penetration request.
Understanding the issue management workflow

About the issue management workflow

The Issue lifecycle sample issue management workflow process template provided with Issue Manager
follows. It is set up to automatically select reviewers to perform signoff tasks from the issue participants.
It also checks the issue review decision when the reviewer performs the signoff task to guarantee that
issue review decision is logged by the current user. Finally, it counts the issue review decisions. You can
also customize the issue management process to best fit your business practice.
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G|
+@ | . ©

Review lssue Reject issua? Issue not rejected

R

I, +

Issue Rejected Issue Deferred Assign Issue & Fix Issue

= HLE|
Or Task +

Issue Fixed & Closed

Issue management workflow process overview
The process flow of the Issue lifecycle sample issue management workflow process is:

1. The change specialist starts a workflow process after verifying that the issue objects and attributes
are complete.

Issue participants are automatically assigned as issue review members by the EPM-adhoc-signoffs
action handler.

2. The change specialist attaches the issue revision as the target (there can only be one issue revision)
and assigns signoff team members for the Review Issue, Assign Issue & Fix Issue, and Final
Review tasks.
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Issue management workflow action handlers _

3. Issue review members review the issue and sign off on it. Reviewers for the Review Issue task cast
a vote by highlighting the target issue report revision and choosing Tools—>Review Issue.

Issue review decisions are counted and issue statuses are updated by the ISSUEMGT-update-issue-
status action handler.

An issue can be rejected, deferred, or verified.

4. When an issue is verified and approved for fix, the issue is assigned to the analyst to provide a
solution to fix it.

5. Issue final approval members must review and approve the issue fix.

The ISSUEMGT-check-review-decision action handler checks if an issue review decision has been
logged by the current user performing a signoff.

Issue management workflow action handlers
The default issue management workflow process template is configured using three action handlers:
* EPM-adhoc-signoffs

Assigns selected issue participants as issue review members. For example, it assigns proposed
reviewers as reviewers for the Review Issue and the Final Review tasks (issue fix approval) and the
proposed responsible party as a reviewer for the Assign & Fix Issue task to fix the issue. Customize
this according to your business practice.

* ISSUEMGT-update-issue-status
Counts the issue review decisions from all reviewers and updates the issue status.
* ISSUEMGT-check-review-decision

Checks if an issue review decision has been logged by the current user performing a signoff. Use
it with ISSUEMGT _update_issue_status. If the user performs signoff (approve or reject) without
reviewing issue, the signoff decision is reset to No Decision to allow the user to review the issue.

Issue management workflow tasks

Review Issue do task 4 [

ey (nmie

Use the Review Issue task to define the Signoff Team profiles. It also provides the subtasks:
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* select-signoff-team to define the users to review the issue.

The select-signoff-team condition task is configured to assign selected issue participants as issue
review members. For example, the EPM-adhoc-signoffs action handler assigns:

* Proposed reviewers as reviewers for the Review Issue and the Final Review tasks (issue fix
approval)

* The proposed responsible party as a reviewer for the Assign & Fix Issue task to fix the issue.

» perform-signoff to allow reviewers to review the issue. Reviewers complete this task by highlighting
the target issue report revision and choosing Tools-»Review Issue to vote on the issue.

The perform-signoff subtask is configured to check the issue report object review record list when

a user performs the signoff (approve or reject). If there is no decision logged by the current user,

the ISSUEMGT-check-review-decision action handler displays the following message advising the
reviewer to perform the signoff by reviewing the issue report revision using the Tools->Review Issue
command:

Pl ease perform signoff by reviewing the issue report revision
from RAC Tool s->Revi ew | ssue.

The signoff decision is reset to No Decision.

The review issue operation completes the signoff (with CR_approve_decision) automatically.

Reject Issue? condition task @

Reject isswa?

The Reject Issue? condition task is configured to count the review records to decide whether a majority
of review votes favor to reject the issue. The number of reject review votes needed to pass is specified
by the ISSUEMGT-update-issue-status handler threshold input argument, which sets the percentage
required to approve the review decision. If the issue is rejected, the issue attributes are updated and the
condition task is set to TRUE.

Issue Rejected do task

Issue not rejecied

The Issue Rejected do task is configured to clean up the review records. The issue is rejected and closed.
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Defer Issue? condition task @

Deler lssua?

The Defer Issue? condition task is configured to decide whether the majority of review records favor

to defer the issue. If the issue is deferred, it updates issue attributes, and cleans up review records.
Otherwise, it assumes that the issue is verified and a fix must be provided. Review records are cleaned up
regardless of the decision.

Issue Deferred do task @

lssue Defered

The Issue Deferred do task is configured to clean up the review records. The issue is deferred.

Assign Issue & Fix Issue workflow task +

Assign lssue & Fix |ssus

The Assign Issue & Fix Issue workflow task assigns the issue to a user by selecting the user as the
reviewer. The assigned user (signoff user for this review task) determines the issue solution. When the
issue solution is ready for final review and approval, the assigned user performs signoff so the workflow
process moves on to the next task. This task is configured to mainly mark the issue as a work in progress.

Final Review <4 |

Final Review

The Final Review workflow task facilitates the issue solution approval. Selected reviewers should review
the issue and solution and perform signoff.

Issue Fixed & Closed @

|ssue Fied & Closed

The Issue Fixed & Closed do task is configured to clean up the review records. The issue is closed.
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Understanding the penetration request workflows

About the penetration request workflows

Three sample penetration request workflow templates are provided with Issue Manager:
* General penetration workflow process (general_penetration_wf)

» Escalated penetration workflow process (escalated_penetration_wf)

* Delete penetration workflow process (delete_penetration_wf)

An administrator must set up the Teamcenter IssueManagement_WF_template preference to identify
the penetration request workflow templates used. It lists the names of workflow templates for
penetration request management. For example:

escalated_penetration_wf
general_penetration_wf

If the structure is already released for this request, and the escalation workflow is available, the request
is sent to escalation workflow; otherwise, it is sent to the general penetration request workflow. After
evaluating a penetration request from their worklist, hull technicians can choose to have the request
continue on in the existing workflow or escalate it to a multi-service penetration.

Penetration request status

As a penetration request progresses through the workflows, its status changes from:

* Submitted (in the hull technician’s worklist but not yet claimed)

» Working (claimed by the hull technician)

* Liability (after being escalated by the originator)

* Multi-Service working (after being escalated by the hull technician)

* Implementing (after being claimed by a structure designer)

* Rejected (after being rejected by either the hull technician or the structure designer)

» Reworking (after being reassigned to the CAD designer or being pulled back by a CAD designer)

* Complete (after closure of a liability or multi-service penetration request, or after structure designer’s
signoff)
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General penetration request workflow

The general_penetration_wf sample penetration request workflow process template provided with
Issue Manager follows.

+ o]

Update Requeast
+ > O e ©
Review Request Liability Request Approvable?
O]

@

Multi service
penatration

+ ks

Request Rejected Implement CutOuts

©]

Helecut Rejected?

y

Mew Or Task 1

Panatrauast

Completes and

The general penetration request workflow sends the decision to create a hole cut to reviewers (Review
Request to determine whether or not it is a liability. A liability is a multi-service penetration where two
penetration requests conflict with each other and the conflicting requests must be resolved through a
more rigorous Change Manager enterprise change request (ECR) process.

* If the penetration request is a liability (Multi service penetration), the penetration request is closed
and a change request process is started.

Issue Management, Teamcenter 2412
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* If the request is not a liability, the reviewers then decide if it should be implemented (Request
Approvable). They can reject it or have it implemented. If they decide to have it implemented, the
structural designer makes the hole cut and the work is reviewed (Implement CutOuts).

* If the reviewers reject the hole cut (Holecut Rejected? is set to True), the CAD designer updates
the request (Update Request) and it returns to the beginning of the process to be reviewed again
(Review Request).

* If the reviewers approve the hole cut (Holecut Rejected? is set to False), the penetration request is
complete (Penetration Request Repeats and Satisfied) and the workflow process ends.

You can also customize the general penetration management process to best fit your business practice.
Escalated penetration request workflow

The escalated_penetration sample penetration request workflow process template provided with Issue
Manager follows.
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+ (=) + o]

Review Request Update Raquest

©

Liakbility

+ b

Update validate
uest

(@)

ulti service
enetration

©

Request Approvable?

o —o + &)
Managr;vrgﬁnt Reques! Rejecled Implement CulCuts

©

+ @ Holecut Rejected?

Management Review

Penetration Lequest

Completes and
atisfied

/
Mew Or Task 1

The escalated workflow is similar to a general workflow but it contains an additional management
review (Management Review) at the beginning of the process.

* If management does not approve the request, it is rejected (Request Rejected) and the workflow
process ends.

* If management approves the request, the request is updated (Update validate request) and reviewed
again (Review Request) to determine whether or not it is a liability. A liability is a multi-service
penetration where two penetration requests conflict with each other and the conflicting requests
must be resolved through a more rigorous Change Manager enterprise change request (CR) process.

* If the penetration request is a liability (Multi service penetration), the penetration request is closed
and an ECR process is started.
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* If the request is not a liability, the reviewers then decide if it should be implemented (Request
Approvable). They can reject it or have it implemented. If they decide to have it implemented, the
structural designer makes the hole cut and the work is reviewed (Implement CutOuts).

* If the reviewers reject the hole cut (Holecut Rejected? is set to True), the CAD designer updates
the request (Update Request) and it returns to the beginning of the process to be reviewed again
(Review Request).

* If the reviewers approve the hole cut (Holecut Rejected? is set to False), the penetration request is
complete (Penetration Request Repeats and Satisfied) and the workflow process ends.

You can also customize the escalated penetration management process to best fit your business practice.
Penetration deletion workflow

The delete_penetration_wf sample penetration request workflow process template provided with Issue
Manager follows.
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=

Review CutOut

Y
© O— @

Delate Hale Cut? Hede is nat remaoved

+ oo

Delete CutOuts from
Slructure

Cutout Removed

It sends the decision to remove a hole cut (Review CutOut) to reviewers. The reviewers check the hole
cut and decide whether or not it can be removed (Delete Hole Cut?), for example, if it is required for
any other reasons and therefore, cannot be removed.

* If they decide it cannot be removed, the request is rejected (Hole is not removed) and the workflow
process ends.
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* If they decide it can be removed, the structural designer removes the hole cut (Delete CutOuts from
Structure). Automatic notification is sent to the designer who originated the request, as well as all
members of the notification list associated with the structural member through which penetration
was requested. The workflow process ends.

You can also customize the delete penetration management process to best fit your business practice.
Assigning participants

Assigning participants

To help track who can work on an issue or penetration request, you assign participants to the issue.

You can set the issue management workflow to automatically assign issue review members from the
issue participants. For example, it can automatically add review members as issue review task reviewers,
the responsible member as the issue assignee to fix the issue, and so on.

About dynamic participants

Dynamic participants are workflow handlers that automatically assign users to perform different
workflow tasks based on the participant types assigned to a change object that has been submitted to
workflow. The default participant types include Analyst, ChangeSpecialist1, Requestor, and Change
Contributor, as well as others.

A change specialist uses the Assign Participants command to assign participants for a change object.
Then, when the workflow that is configured for dynamic participants reaches a task and needs to
determine who the participants are, the workflow looks at the current assignee for the participant type
(for example, Reviewer for a Review task) and sends it to that user’s inbox. If the user assigned to a
participant type changes after the workflow starts, the workflow automatically recognizes the new user
for any tasks that have not started.




About dynamic participants _

\ List of participants
Change partielp

Object ssign participants

£ Pariicipants

po Proposed Reviewsrs

""" | Proposed Responsible party
] b B Analyst
----- Fh Change Implamentation Board
L. © Change Specialist |
+| T Requestar

Submitted to
workflow

Retrieved when a
task is initiated

]
] B —»

Assign Specialsi

Assign Analyst

(=)

Add Stabus Raeleased

Agree Salulion Impact Analysls, Define Solutions

If a workflow is not set up to have dynamic participants, the participants are determined explicitly by
selecting users. Those participants are fixed and cannot change.

Caution:

A user is assigned as a participant with a specific group and role. The user’s session context must
be set to the same group and role they are assigned as to satisfy any Change Manager conditions
that are applied.
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Assign participants

Note:

* To use the Assign Participants command to assign review members based on their roles, a

workflow must be configured to use dynamic participants.

See your workflow administrator for information about how your company’s issue or
penetration request management workflows are configured or learn about designing a
workflow with dynamic participants.

You must have permission to assign participants.

See your workflow administrator for your permissions. For information about controlling who
and when can assign participants using Change Manager conditions, see About configuring
conditions to control the actions of participants and the BMIDE for Data Model Design.

Select the issue report or penetration request that you want to assign participants to.
Choose Tools—Assign Participants.

In the Assign Participants dialog box, select the participant type (for example, Change Specialist

.

Click either the Organization or Project Teams tab and select a user to assign to the participant
type.

You can search for a group, role, or user in the box below the tabs.

Use Resource Pool Options to assign a set of group or role members as participants instead of
individual users. When a group or role is selected, additional options become available.

* If you select a group, you can click Any Member so any member of the group can be the
participant for that type.

* If you select Proposed Reviewers and then select a group, you can click All Members to assign
all members of the group.

* If you select a role under a group, you can click Any Member and choose Specific Group to
assign any member of the combined group and role as the participant type or choose Any Group
to assign any member of any group and the selected role as the participant type.

To remove a user as a participant, select the user under the participant type and click Remove.

To change a participant, select the user under the participant type, select the new user in the
Organization or Project Teams tab, and click Modify.




Permissions for assigning participants _

7.  Click Add.

8.  When you are finished assigning participants, click OK.

Note:

If the change object does not automatically display the assigned participants in the Summary, it
may be necessary to manually refresh the window.

Permissions for assigning participants

The type of participant you are determines what types of participants you can assign:

Requestor
The user who created the issue is automatically assigned as the requestor.
* Change specialist |
The administrator assigns the change specialist. There is only one change specialist allowed.
* Analyst
The change specialist assigns the analyst. There is only one analyst allowed.
* Proposed reviewers and responsible parties

These are users who are proposed as reviewers or as the one responsible for fixing the problem
(analyst). Anyone can assign proposed reviewers or the proposed responsible party.

Only one user is allowed as the proposed responsible party, while multiple users are allowed as
proposed reviewers.

Initiate a workflow

1. Verify that the data being included in the issue or penetration request to be submitted to workflow
is checked in.

2. Select the issue report or penetration request revision to be included in the workflow and choose
File->New->Workflow Process.

The New Process Dialog box appears. The value in the Process Name box defaults to the name
of the issue or penetration request revision you submitted to workflow. The attachments listed are
those associated with the issue revision.
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3.

4.

5.

Set the Process Template box to the desired workflow, such as Issue lifecycle.
(Optional) In the Description box, type a description.

In the New Process Dialog box, click the Process Template tab to view the graphical display of the
process template, as shown for Issue lifecycle.
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g R s
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+ I lssue not rejected
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!

+
+

1
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B b Deferred

- E. gl B f"‘".l -.".’.I [ ?.
m leaue Fiaed f Closed ol B it D Bujct lame® T ma

Biame:  asue ececle

Description

(@
Db Didim’

2 @ » ' -
€

Note:

The next step is not necessary if you have the EPM-adhoc-signoffs workflow action handler
set to automatically assign users.

(Optional) Assign reviewers for the review tasks, such as the Review Issue, Assign Issue & Fix
Issue, and Final Review review tasks:

a. Inthe New Process Dialog box, click the Assign All Tasks tab.

b. Inthe left pane, select a profile or users under a review task to assign and in the Organization
pane, select the group, role, or user to perform the signoff.

c. Inthe left pane, select a review task and in the Review Quorum area, set how the review
count should be configured, either as a fixed number of reviewers or as a percentage of
reviewers.

d. Select Wait for Undecided Reviewers to not allow the workflow to continue until all
reviewers have decided.

Click OK in the New Process Dialog box to submit the data to the workflow.

The process symbol ¢ indicates the data is submitted to workflow.
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Note:

Because you are the initiator of the process, the next task is sent to your My Worklist (inbox).
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8. Administering the issue management
process

Administering the issue management process

Because issue management processes differ from company to company, you can configure and
customize Issue Manager to meet your business needs and help you follow your documented process.

Set Issue Manager options.

Set up groups and roles for users to be involved in the change process.

(Optional) Define custom change management objects.

Configure conditions to control the actions of participants.

Create and configure workflows for the change process.

Configure review decisions

Setting Issue Manager options

You can set the following options to further configure Issue Manager:
» Set preferences for how issues and the images associated with them are displayed.

* Customize or remove the lists of values (LOVs) that appear in the New Issue Report dialog box when
users create an issue report. By default, the lists that appear are Design Review Gate and Issue
Category.

¢ Configure the viewing and managing of Teamcenter visual issues.

About setting up users

You will want to set up rules to restrict issue management actions to authorized users.

* Use the Organization application to define groups and roles and associate the roles with the
participant types. A typical approach is to create a change management group to contain the change
specialists.

* Use the Business Modeler IDE to define the conditions that drive access rules used to manage object
permissions. In the example shown here, the business rule for creating ECRs is limited to those who
are members of the Change Management group:

8-1



_ 8. Administering the issue management process

i sChangeRequest Cr eat abl e
OR u. group_nanme = "Change Managenent"

It is recommended that you create the roles with a similar name to the participant types to avoid
confusion. For example, create the Change Specialist role to match the ChangeSpecialist1 participant

type.

A sample of a typical organization tree is shown in the figure.

S 2 Group
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Change Administrator

- - o

Group Member 1 r Group Member 2
2 rgreen o mread
Role: Fiole:
Change Adminisirator Change Administrator

Group
g- 2 Engineenng

& Riobes:
Cﬁs Change Analyst

Designer

Group Member 3 Group Member 4 Group Member 5
2 rgreen A% mread S mread
Roles: Role:
Change Analyst Change Analyst DB‘SFDHEF
Dasigner

Defining custom change management objects

Use the BMIDE for Data Model Design to create custom change management objects representing the
change objects for your change process. The custom objects you create are templates of the different
change processes to be used at your site. End users create instances of these change objects, such as
change requests, and use them in their workflow processes. Also, to enable users in the change process
to create the custom business objects, make new conditions allowing the creation.

List of standard change management business objects.
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In addition to creating the custom change management objects, you can also:

» Configure Change Manager pseudofolders in which to store objects related to the created objects and
which automatically appear when a user creates an object of that type.

* Create new forms as needed in which to hold custom information about the change management
object.

* Add properties, such as change type, to existing change management objects.

If you want to add persistent properties to change objects, you can extend business classes directly
using the Business Modeler IDE. You can also create a dialog box definition by specifying the required
and optional properties for an instance creation. Subclasses that do not have their own dialog box
definition inherit the dialog box definition of their parent class. To display new properties, you must
add them to the style sheets defined for the change object.

Note:

Before working with Change Manager objects, you must install the Change Management template
(cm_template.xml file) to your project. During installation, select Change Management in the
Business Modeler IDE Templates panel in Teamcenter Environment Manager.

About configuring conditions to control the actions of participants

Using the Business Modeler IDE, you can configure Issue Manager to fit your business process by setting
specific conditions or rules (called Change Manager conditions). They control which participants can
perform specified actions.

To see a listing of all the Change Management on Active Workspace — Usage conditions, see the
Teamcenter Data Model Report in the Teamcenter documentation on Support Center.

Creating custom workflows

If you do not want to use the default Issue Manager workflow processes, you can create your own or
configure the existing ones to meet your business requirements.

Note the following:

* For penetration requests, set up the Teamcenter IssueManagement_WF_template preference to
identify the penetration request workflow templates used. It lists the names of workflow templates for
penetration request management. For example:

escalated_penetration_wf

general_penetration_wf
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* To have the issue management workflow automatically assign issue review members from assigned
participants, configure your workflow for dynamic participants.

* Configure the review decisions that appear in the Review dialog box.
Configuring review decisions

Configuring and localizing review decisions

The review decisions that appear in the review decision dialog box when users review an issue or
penetration request are defined in the issue review decision list of values (LOV) in the Business Modeler
IDE and localized so they appear in the local language of the user. You can customize or the remove
these decisions to fit your business practices. The default review decisions are listed in the following
sections:

* |ssue report default review decisions
* Penetration request default review options

Once you define the LOV, use the ISSUE_review_issue_menu_items_at_workflow_task preference to
set the review decisions for each of the penetration request workflow templates. The valid format is the
task name followed by the list of review decisions for that task, separated by a semicolon.

Example:
Review Request;Defer;rejectRequest;approveRequest;holdRequest;

Final Review;approveHoleCut;rejectHoleCut;removeHoleCut;

The workflow obtains the current task for the request, and determines if that task is listed in the
preference. If it is, it displays the review decisions for that task in the review decision dialog box at
runtime. The action handler associated with the review tasks counts the decisions to see if one has a
majority defined as threshold (the default is 51%).

Review decisions in the preference’s value array, the issue review decision LOV, and the workflow action
handler that counts the review decision must match.

Issue report default review decisions

* For the Review Issue workflow task, the Decision list box of the Review Issue dialog box is populated
with Defer, Reject, and Approve Issue allowing the workflow to go in different directions.

e Defer

Render a review decision that the issue should be deferred.
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* Reject
Render a review decision that the issue should be rejected.
* Approve Issue

Render a review decision that the issue is confirmed and should be assigned and fixed immediately.

D Review lssue b__(l

ER IR-000002/8;5-test2

Process: warkflow process For object IR-000002 )4
Review Task: Review Issue
Decision: approve Issue W
Defer
Reject
Conmens m
[ Ik ] [ Cancel ]

* For the Assign Issue and Fix Issue workflow task, the Decision list box of the Review Issue dialog
box contains Submit Fix for issue assignee to submit fix.

9 Review Issue [zl

Efl R-000002)8;5-test2

Process: warkflow process For object IR-000002 )&
Review Task: Assign Issue and Fix Issue

Decision; Subrmit Fixx W

Subrnik Fix

Camments:

Ok ” Cancel ]

* For the Final Review workflow task, the Review Issue dialog box only contains Approve Fix for
reviewers to approve the fix to the issue. Reject is not desirable because a reject decision would hold
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up the workflow process. It is expected that reviewers should work with issue team members to reach
a final solution that can be approved.

M Roview Issue

Efl 1r-000002)8;5-test2

Process: workflow process For object IR-000002/4
Review Task: Final Review

Decision: Approve Fix  »

Approve Fix

Corments:

[ Ok ] [ Cancel

Penetration request default review options

The review decision dialog box has the following defaults for the sample penetration request workflows.

defer

* reject

* approveFix

* close

* reopen

* approvelssue

* noDecision

* approveRequest
* rejectRequest

* deleteRequest
* obsoleteRequest

* escalateRequest
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* holdRequest

* approveHolecut
* rejectHolecut
* removeHolecut

e submit
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